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Handbook for the SX Oculus PRO Colour 

All-Sky Camera 

The Oculus PRO Colour is a high resolution, very compact wide-field camera. The camera and 
internal dew heaters are powered through the 12V DC input and camera is controlled via a single 
USB2.0 computer connection. The colour version is intended for full-sky monitoring of weather, 
clouds, pollution etc. but can be used at night by opening the aperture of the lens. It will provide 
high quality images, while operating unattended for long periods. The ‘megapixel’ resolution F/2 
fish-eye lens provides horizon to horizon coverage with very little star image distortion across the 
entire field. 

The Oculus PRO Colour utilises a sensitive Sony CCD (the ICX825AQ) with an array of 1392 x 1040 
pixels in a ‘2/3rd-inch’ format sensor. Although the chip is not cooled, it has a very low dark signal 
and very little readout noise, so it can be used to image faint stars at night by opening up the lens 
stop and extending the exposure times. The small pixel size and high resolution lens give excellent 
definition and a good sized screen image format. 

A strong polycarbonate hemispherical dome houses the lens assembly and this dome is easily 
removed for cleaning, when necessary, a spare dome is also included with the Oculus PRO Colour. A 
12v DC input socket provides power to the camera and the dew sensing circuitry which controls the 
internal heating resistor to be to prevent dewing of the lens and dome on humid nights. The entire 
assembly comes equipped with a standard tripod bracket for mounting. 
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The Oculus PRO Colour specification: 

 

• CCD type: ICX825AQ Sony ExView II CCD with low dark current and vertical anti-blooming. 

• CCD Full resolution pixel data: Pixel size: 6.45uM x 6.45uM, Image format: 1392 x 1040 
pixels 

• CCD Image area: 8.98mm (Horizontal) x 6.71mm (Vertical). 

• CCD quality: Grade 1 

• Spectral Response: QE max at 580nM (~75%), 50% at 400nM and 770nM. 

• Readout Noise: Typically only 3.5 electrons. 

• Full-well capacity: Greater than 23,000 e- (unbinned) 

• Anti-blooming: Overload margin greater than 1000x. 

• Dark current: Less than 0.1 electrons/second @ + 10C ambient. 

• Data format: 16 bits. 

• System gain: 0.3 electrons per ADU 

• Lens details: 2.5mm FL F/1.2 150 degree ‘Fish Eye’ or 1.55mm FL F/2 180 degree ‘Fish Eye’  

• Computer Interface: Built-in USB 2.0 compatible interface. 

• Image download time: Typically 0.6 seconds at full resolution using USB 2.0. 

• Power requirements: Camera & Dew Heater require 12v at 1 amp max. 

• Input connection: ‘Mini B’ USB socket for USB2.0 and a 2.1mm jack for +12v Camera & 
Dew Heater supply. 

• Cooling system: Ambient air cooling. 

• Viewing dome: High quality polycarbonate hemisphere (replaceable) 

• Overall size: 150mm tall x 95mm diameter 
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Installing the Oculus PRO Colour: 

 
Before connecting the Oculus PRO Colour to your computer, please install the appropriate drivers for 
your operating system from the USB drive supplied with your camera.  
 
The supplied USB stick contains all the drivers and software. To install the drivers: 

1. Select the folder for your operating system (32bit or 64bit) 
2. Double click on the “Install Drivers.exe” 
3. Follow the prompts in the installer and click ‘Finish’ at the end of the install. 

 
If you encounter any problems, read the README file on the USB drive or you can download the latest 
drivers from our web page at https://www.sxccd.com/support/resources. 
 

To install Starlight Live (‘Live-stacking’) software: 
1. Double click on the Starlight Live folder on the USB drive. 
2. Double click on the Setup.exe program 
3. Follow the prompts to fully install the software on to your computer. 
4. Plug in your Oculus PRO-Colour (Ultrastar-C) camera – (Wait for the Install New Hardware 
Wizard to complete) 
5. Double click on the Starlight Live.exe icon on your Desktop or from your START button on 
your computer.  

The Oculus PRO Colour (Ultrastar-C) control software is UltrastarC.exe. To install this: 
1. Double click on the Oculus PRO Colour (Ultrastar-C) Software folder on the USB drive. 2. 
Double click on the Setup.exe program 
3. Follow the prompts to fully install the software on to your computer. 
4. Plug in your Oculus PRO Colour Camera (Ultrastar-C camera) – (Wait for the Install New 
Hardware Wizard to complete) 
5. Double click on the UltrastarC.exe icon on your Desktop or from your START button on your 
computer. 
6. The first time you use the software, click on “File” then “Set Program Defaults” You will get a 
message, “Warning – No INI File found – Please set defaults” 
7. Click “OK” – The Set Program Defaults box will appear. 
9. Click on “Save Changes” and you are all set to start using the camera. (The INI file that was 
being asked for initially has now been created and you will no longer see the Warning message)  

Other 3rd party software packages such as AstroArt, MaximDL, SkyX and others, all support the 
Oculus PRO Colour  (Ultrastar-C) either with native drivers or through ASCOM. Our latest driver 
can be found on our website: https://www.sxccd.com/drivers-downloads  
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Setting up and using the Oculus PRO Colour: 

The best site for your Oculus PRO Colour camera will depend to a great degree on your surroundings 
and nearby sources of artificial light. An all-sky lens will image everything in your area and the 
reflections of artificial lights in the dome and lens can be objectionable. Try to locate it in a 
shadowed area with as good a view of the sky as possible. If you cannot avoid stray light getting into 
the field of view, then raising the effective horizon is an option. 

Mounting the camera assembly is usually done by using the ¼ Whitworth tripod screw hole in the 
attached bracket. A camera tripod will provide an adequate mounting for temporary use, or a 
suitable mast and fixing screw can be erected to permanently mount the Oculus PRO Colour several 
feet above the ground. It is wise to mount the unit as high as possible, so that the effects of low-
hanging fog and dew are reduced, and stray light is minimised. It is also helpful if the camera is 
positioned above a source of warmth, such as a house roof, to help keep the dew at bay. 
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The minimum setup requires the USB cable to the monitoring computer as well as the 12V DC 
supply. This should be as short as is practical, but it will probably be necessary to have a fairly long 
lead if the Oculus PRO Colour is mounted high on a mast or roof. As the camera power is taken from 
the 12V supply, any long leads should be as heavy as possible to reduce the internal resistance. The 
USB2.0 cable should be kept to a minimum and if an extension is required, a high quality USB active 
extension cable should be used.  

 

Depending on your setup, there is a possibility of earth loops due to the internal dew heaters 
switching on and off. This may cause the USB communication side to be a little problematic and as 
such, we have included a ferrite core which can be fitted to the USB cable to eradicate this affect. It 
is very simple to install, simply wind the USB cable around the ferrite core. We recommend at least 3 
time, but 4-6 times is best as shown. It is best to do this at the computer end as this will put less 
pressure on the USB connector in the camera, prolonging the life of the camera.  
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The Oculus PRO Colour is designed to minimise any lens and dome dewing problems, but these are 
very common in optical systems that are cooled by radiation to the sky. It is very likely that you will 
have dewing on humid nights unless the dome is kept warm by powering the internal heater via the 
12v socket on the rear of the assembly. This socket can accept a 2.1mm coaxial power plug from any 
12v DC supply capable of driving at least 1 amp - the polarity is center positive. Heating will increase 
the dark signal of the camera, so the dew sensing circuit is set to approximately 50% moisture 
saturation in the air before turning on the dew heaters automatically.  

 

A rear view of the Oculus PRO Colour, showing the heater socket and USB cable. 
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Imaging with the Oculus PRO Colour Camera:  

The software ‘Starlight Live’, makes Live Viewing very easy and is highly recommended. 
Starlight Live recognises the Oculus PRO Colour (as an Ultrastar-C) automatically and all that 
you need to do is to open the software, select a suitable exposure time, typically 1 second, and 
click on the “Play” button. Follow the steps below:  

• Start the Starlight Live Program by clicking on the icon.  
• Deselect the “Auto Align” button in the “Channel Selection”  
• Select the “Image Export Tab” on the left-hand side and then click on “Export Raw 

Images” At this point you will need to select the directory where you would like the 
images saved.  

 

• Select the “Stacking Tab” on the left-hand side and ensure that “Enable Stacking” is not 
checked.  

• Select the “Exposure Control Tab” on the left-hand side of the screen.  
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The Camera Properties will show that the Starlight Xpress Ultrastar-C camera is 
connected and ready to go. This camera is the one inside your Oculus-C.  

• Select the Colour Space to RGGB which is the correct decoding for your camera.  
• Ensure Binning is set to 1x1  
• Adjust the exposure time, I would suggest 1 second is a good starting point for day light 

images.  

• 
Click on the Play icon to start the camera exposing and the Stop button to stop the camera 
exposing.  
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Select the “Display Processing Tab” This allows you to adjust the Black Level and White Level of 
the image and also any colour offsets that you require using the sliders.  

 

The AllSkEye software which is freely available at https://allskeye.com is fantastic software 
for use with the Oculus PRO Colour camera. It has so many amazing features and the PRO 
version of the software is very inexpensive.  

At Starlight Xpress, we would highly recommend trying the AllSkEye software! 

 

 

 

 

 

 

 

 

 

 

 

 

https://allskeye.com/
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The Starlight Xpress Oculus software was designed with the monochrome Oculus in mind. It 
will work with the Oculus PRO Colour, however, the images will be in raw monochrome 
format and will need to be manually colour synthesized to extract the colour data.  

Imaging with the Starlight Xpress software 

With the Oculus PRO Colour connected to the PC, open ‘Oculus PRO Colour_USB.exe’ and find the 
‘Set program defaults’ menu under the ‘File’ heading. If this is the first run of the software, you will 
get a warning about the ‘ini file not found’, but ignore this and click on OK – then open ‘set program 
defaults’ from the text icon . You should now see a screen similar to the one shown below: 

 

 

The defaults shown above are a typical example, but you can change the settings to suit your 
preferences. The main thing to do is to set up the address of the ‘Autosave’ folder, so that your 
images will be saved to a defined location. The ‘Ignore VID/PID’ MUST be selected for the software 
to recognise your Oculus PRO Colour camera. Once the defaults have been set to values which you 
think will be approximately correct, save the settings and open the camera interface by pressing the 
camera icon in the top menu. You will see something like this: 
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If this is an initial setting up session, set the ‘Autosave’ to off and select ‘Continuous’ mode. The 
exposure time for a dark sky can be 20 seconds, or more, but for initial alignment and testing, set 5 
seconds and press ‘Take Photo(s)’. You should see a sequence of images on the display and you can 
experiment with the Oculus PRO Colour orientation and location to get the best views. The focus 
should be good, as supplied, but if necessary it may be adjusted by unscrewing the large outer ring 
and lifting off the dome. Loosen the small lock screw on the lens and gently rotate the top lens ring 
to refine the focus. 

Re-lock the lens when satisfactory and replace the dome. 

You can greatly improve the image brightness and contrast by setting up the ‘Max palette stretch’ 
option in the ‘View’ menu. I recommend using the ‘Linear’ stretch and adjusting the black and white 
levels for the best view. 
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Once the position and focus are good, try running an image sequence in ‘Autosave’ mode. An 
exposure time of 30 seconds is generally good for basic sky monitoring, but shorter exposures might 
be better to minimise sky glow when meteor imaging. Set up a suitable number of image frames in 
the ‘No. of exposures’ box and check the ‘Autosave’ box. Pressing the ‘Take Photo(s)’ button will 
now start a sequence and save the images as FITS files into your chosen Autosave folder. Clearly, a 
lot of images will occupy a great deal of hard disk space, so make sure that you have plenty 
available! The maximum autosave number for AVI creation, is 1000 images and this will cover about 
8 hours of 30 second frames, while filling about 1GB of hard disk space. For tidiness and avoiding 
any mixing of old and new images, I recommend pressing the ‘Empty current directory’ button 
before starting your sequence. If you want to keep a previous session of saved images, you must 
move them to another folder before starting a new sequence with the Oculus PRO Colour. Your 
images will be saved in the Autosave folder as numbered FITS files – IMG1.FIT, IMG2.FIT etc. and will 
be added to any that are already there. 

Most users will probably not need dark frame subtraction to get a satisfactory result, but this option 
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is available if you need to suppress any hot pixels etc. Cover the Oculus PRO Colour dome with a 

black cloth or opaque container and then take an exposure to match the length being used in your 
image sequence. The resulting dark frame should be saved to c:\dark.def and the ‘Auto remove dark 
frame’ check box selected in the camera menu. The dark will then be subtracted from all future 
images. Note that the dark noise is temperature sensitive and so you will get cleaner images if the 
Oculus PRO Colour is cold Unfortunately, if the air is humid, this is also likely to lead to dew or frost 
forming on the dome, so you might find that running with the heater on is often necessary, and this 
is where dark frame subtraction can be particularly useful. Another option is to create a ‘Hot pixel 
map’ and apply this to your images when creating an AVI file and this will be described below. 

After an imaging session, you will probably want to view a movie of the entire sequence to look for 
interesting events. This is easily done by creating an AVI file from the stored FITS images. Open the 
‘File’ menu and select the ‘Create AVI from FITS files’ option. The best results will be obtained if you 
adjust the visualisation of a sample image to give the best view, using the Max palette stretch 
options in the ‘View’ menu. Adjust the brightness and contrast to give a nice result and then run the 
AVI create. The program will use your view settings on all the images while creating the movie file. 
The AVI generator will add an image file number at the bottom left of your AVI images and this can 
be useful when searching for frames that contain interesting events. Some software, such as 
‘Windows Media Viewer’, will sometimes hide this legend behind their control slider and so I 
recommend checking the ‘Frame label offset’ option to shift it up be about 200 lines. You will see 
that a ‘Hot pixel map’ can be applied to your AVI frames during AVI generation. This will remove the 
random hot pixels which are always present in CCD images, without affecting the rest of the image 
frame, and so may be preferred to dark frame subtraction. To use the hot pixel removal, you need to 
record a fairly long exposure dark frame (say 60 seconds) and then open the hot pixel map 
generator from the ‘Edit’ menu. The slider will permit you to set a threshold for the hot pixels and 
you should adjust this so that it detects no more than 100, or so. Setting it too low will damage your 
image quality. Record the resulting map and then select this from the AVI generator menu. 

As your source images are unaffected by the creation of the AVI, you can search through them for 
meteors, satellites etc., as seen in the AVI, and then select, process and save these images to another 
folder. 
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Oculus PRO Colour maintenance 

 

The Oculus PRO Colour head is designed for a long and reliable lifespan and needs very little 
maintenance to keep it in good working order. The only common issue is with dust and dirt particles 
which collect on the dome and can shade areas of the image field. These are best removed with a 
quick blast of compressed air from a ‘Dust off’ aerosol, or similar air blower. More permanent marks 
may be removed with a drop of spectacle lens cleaner on a soft cloth. Try to avoid vigorous rubbing, 
especially when removing gritty dirt, or you may scratch the plastic. A spare dome is supplied with 
the Oculus PRO Colour and replacements may also be purchased from our dealers. 

The Oculus PRO Colour dome is spaced off from the base ring by small pads. This allows air to 
circulate through the vent holes and inside of the dome, to reduce the tendency for dew to 
condense on the inner surface. Please ensure that these pads remain in place when removing the 
dome for cleaning. 

The fan at the rear of the Oculus PRO Colour provides a gradual flow of air from the outside of the 
camera, across the built-in dew heaters and into the dome cavity. A paper air filter is fitted to the 
fan to significantly reduce airborne particles from entering the camera but over time, this may 
require changing. Your Oculus PRO Colour is shipped with additional filters which are easily changed 
by removing the four panhead screws on the rear of the Oculus PRO Colour, then removing the filter 
support ring. A new filter can be put in place and the support ring refitted. 
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Dear Observer, 

Thank you for purchasing a Starlight Xpress product. We are confident that you will gain a great deal of 
satisfaction from this equipment, but please read carefully the instruction manual, supplied with your 
product, to ensure that you achieve the best performance that it is capable of providing. 

As with most sophisticated equipment a certain amount of routine maintenance is necessary to keep the 
equipment operating at its optimum performance. The maintenance has been kept to a minimum, and is 
fully described in the manual. 
 
Starlight Xpress Ltd. warrants all Starlight Xpress products to be free from defects in workmanship and 
materials, under normal operating use and conditions, for a period of two (2) years following the original 
invoice date. This limited warranty does not cover failures due to abuse, accidental damage, or when 
repairs have been made or attempted by anyone other than Starlight Xpress. A defective product 
meeting the warranty conditions set forth herein will be replaced or repaired at no charge.  
 
Replacement or Repair 
If a product arrived with the user and is immediately faulty, Starlight Xpress, if contacted within 30 days 
of purchase, and with evidence proving a defective product, will offer a free replacement, subject to the 
verification of the defect or malfunction. The customer shall return the complete product package, 
including all parts, accessories, and manuals, etc. for a replacement.  
 
Exclusions: 

1. The equipment shall only be used for normal purposes described in the standard operating 
instructions, and within the relevant safety standards of the country where the equipment is 
used. 

2. External mechanical force (i.e. dropped, scratched sensor window, damaged metalwork, a 
broken or damaged USB port, power supply connector etc.)  

3. Water or moisture inside the product due to improper storage or use.  
4. The guarantee shall not apply to the equipment damaged by flood, fire, earthquake, lighting 

strike etc. (Force majeure) 
5. Disassembling, repairing, or refurbishment made or attempted by anyone other than Starlight 

Xpress without prior authorisation.  
6. This guarantee shall not apply to components that have a naturally limited life. 
7. Starlight Xpress’ decision in all matters is final, and any faulty component which has been 

replaced will become the property of Starlight Xpress Ltd. 

This Limited Warranty is NOT transferable and applies ONLY to direct customers who purchase product 
from Starlight Xpress or/and its authorized dealers. 
 
Please don’t forget to register your SX Product at https://www.sxccd.com/support/warranty-policy-and-
registration/ to initiate your warranty 

 

For further info. or advice, please contact us: 

Starlight Xpress Ltd., Unit 3, Brooklands Business Park, Bottle Lane, Binfield, Berkshire, England. RG42 
5QX 

Tel: +44(0)1184026898 
Email: info@starlight-xpress.co.uk 
Web site: http://www.sxccd.com 

 

https://www.sxccd.com/support/warranty-policy-and-registration/
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